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1 Welcome

ACT-To-Outlook Professional
6.6

Compatible with ACT 2000 and ACT! 6.0 and Outlook 2000 SR-1 and above,
Outlook 2002, Outlook 2003 and Outlook 2007!

The purpose of ACT-To-Outlook Professional is to provide users with a tool to quickly convert, update,
and transfer an ACT! Contact database into Outlook Contacts. Powerful update and selection options
makes this product ideal for anyone that wants to keep Outlook updated from ACT!.

Highlights of ACT-To-Outlook Professional:
· Inclusion of Outlook Cleaner. Clean your outlook folders rapidly with the click of a button.
· Auto-Map generation of all standard and user defined ACT! fields.
· Single Click Conversion. Use either our standard field mapping or setup your own customized

field mapping. Click on a button and convert all the contacts.
· Active Lookup Support. Convert the Active Lookup in ACT! with a click. Also, convert single

contacts as well as groups!.
· Integrated with Outlook. Closely integrated with Outlook for easy of use and fast conversions. In

addition, you don't get the persistent Outlook security warnings during the conversion.

· Convert Single Contacts, ACT! Groups or the whole database. Convert selected contacts
from the ACT! database, convert an ACT! group or convert the whole database into Outlook.

· Custom Field Remapper. Convert standard fields or custom fields from ACT! into Outlook User
properties.
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· Background Processing. Setup ACT-To-Outlook Professional to convert data at scheduled
times.

· Unique Duplicate Identifier. Once a database has been converted, ACT-To-Outlook Pro
establishes a unique 1-To-1 relationship between the ACT! Item and the Outlook Item.

· ACT! Items Converted. History, Attachments, Notes, Calendar, Groups, Standard Fields, Custom
Fields, To Do's, Meetings, etc..

· And much, much more....
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2 Introduction

The purpose of ACT-To-Outlook Professional is to provide users with a tool to quickly convert, update,
and transfer an ACT! Contact database into Outlook Contacts. Powerful update and selection options
makes this product ideal for anyone that wants to keep Outlook updated from ACT!.

2.1 Why Use ACT-To-Outlook Professional

ACT-To-Outlook Professional is designed for users that have an active ACT! database and want to
transfer data from the ACT! database to the Outlook folders with modifications that make the data in
Outlook more accessible and relevant.

Major Features
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Ease of Use Install, and you are ready to go. Merge and folder flexibility
allows you to keep your ACT! Contacts updated with your
Outlook.

Multi-User
Support

ACT-To-Outlook Professional supports ACT! Multi-User
configurations and properly converts the activities relating to
the currently logged-in user.

PIMs Supported ACT-To-Outlook Professional supports ACT! 2000 (build
5.0.4.495) and ACT! 6.0. In addition, Outlook 2000, 2002,
2003 and 2007 are supported.

Field Conversion
Capabilities

All the fields in ACT! can be converted, whether they are
standard fields or user defined fields. In addition, fields that
are mapped to Outlook Custom forms are also converted.

Field Remapping
Capabilities

All fields in ACT! can be remapped to Outlook fields, whether
these fields exist in Outlook or not. The field remapping is
maintained if you exit ACT-To-Outlook Professional.

ACT! Items
Converted

The following ACT! Items are converted to Outlook
equivalents:

· Todo's - ACT! Todo's are converted into Outlook Tasks
with the same time-reoccurring properties.

· Calls - ACT! Calls are converted into equivalent Outlook
Tasks.

· Meetings - ACT! meetings are converted into Outlook
Appointments.

· History/Notes - All ACT! history items can be converted
into Outlook Journal Items with links to the
corresponding contacts. In addition, all and any notes,
attachments, and files existent in the History is converted
into Outlook. History Filtering allows the user to select
which history type to convert.

Selective
Conversion

You can convert contacts from a selected list of contacts.
Simply choose the contact and all the fields, activities and
history are converted into Outlook.

Group Conversion You can select contacts belonging to an ACT! group and
convert only the group.

State-of-the-art
duplicate checking

When you first want to convert your ACT! database into an
existing Outlook contact folder, we check for corresponding
contacts according to the following criteria

· Email Address.
· First and Last Name and City
· Company Name and City

Only when these criteria fail do we create a new contact.

Once the first conversion has been made, ACT-To-Outlook
Professional keeps a 1-to-1 match between the ACT!
database and the corresponding Outlook item so that no
duplicates are ever created.

Outlook Overflow
Checking

Due to Outlook's restrictions on the size of the folder (16K
items), ACT-To-Outlook Pro will automatically create new
folders during the conversion so that Outlook does not crash.
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2.2 New Features with 6.0

ACT-To-Outlook Professional 6.0 comes loaded with added features:
· Added Outlook Clean. New tool helps users clean up the mounted folders with the click of a

button.
· New Auto-Mapping Feature. Beyond the standard field map, you can map all the fields from

ACT! to Outlook with the click of a button. Auto generation of user defined fields makes this
process incredibly easy!!!

· Groups and Subgroups Processing. Finally, groups and subgroups are processed to the
categories field in Outlook

· Online .PDF Manual.
· Extended Outlook 2003 and 2007Support.
· Faster, easier, and better!!!!

ACT-To-Outlook Professional 5.0 comes loaded with added features:
· Active Lookup and Contact support. Create a lookup in ACT! and then just press a button to

convert all the contacts in the lookup, right from the ACT! toolbar.
· Groups and Lookup support. Select groups from your ACT! database and convert only that

group. Also, setup a lookup in ACT-To-Outlook Professional and convert only those contacts.
· Enhanced Interface. Better interface and easier to use.
· ACT! Icon Support. Add the conversion actions into your ACT! toolbar.
· Group Hierarchy Conversion Support. Convert all the groups into Outlook and maintain the

hierarchy of all the groups.
· Customized FileAs Support. Customize the way your contacts are filed in Outlook. Control their

Destiny!
· Enhanced Platform Support. The software now supports Outlook 2000, 2002, and 2003.
· Faster, easier, and better!!!!

2.3 Help on ACT-To-Outlook Professional

 You can obtain help for ACT-To-Outlook Professional in the following ways:

· The help file shipped with the product. The help file provided with ACT-To-Outlook
Professional is the most recent help file when this version of ACT-To-Outlook Professional was
created. We provide, an online version of this help file which may be more up-to-date than the
shipped version

· The online help file. This is the most updated version of the help file. When additions and
changes are made to the help file, they are always posted on the online help file. To access it,
click here.

· Contact Support. You can obtain free email support from ACT-To-Outlook.com. Make sure
that you explain your problem/question with as much detail as possible. Use the support form
by clicking here.

· Personalized, one-on-one support. ACT-To-Outlook.com will provide personalized, one-on-
one support to paying customers. Support is provided on an hourly basis. If you are interested
on one-on-one support, you can purchase it by clicking here. If you are based outside the U.S.,
schedule a time to call so that we can make sure the best support person is available to receive
your call.

· Suggestions. ACT-To-Outlook.com is driven to provide software solutions that will satisfy our
customers. Your input is important to us and we want you to contact us if you have any
suggestions on added features or even improvements we can make to our products in order to
make them better. Please click here to submit a suggestion.
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2.4 How to Buy ACT-To-Outlook Professional

ACT-To-Outlook Professional is distributed worldwide by a variety of resellers and
distributors.

To Purchase
Click on the Registration->Purchase menu option of ACT-To-Outlook Professional and
you will be taken to the purchase page for the product.

Home page
http://www.ACT-To-Outlook.com.com
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3 Installation

Installation of ACT-To-Outlook Professional  is straightforward. The following is needed

· You'll need approximately 8mb of hard disk space
· ACT! 2000, build 5.0.4.495 or ACT! 6.0 installed on your system
· Administrator Privilege if running Windows XP, XP Pro, and 2000

To install, simply execute the ACT-To-Outlook Professional executable and follow the directions to
install the program.

Once installed, ACT-To-Outlook Professional may be accessed two ways:

     1. Via the ACT! Toolbar

2. From the windows start menu:
Click on the Start->Programs->ACT-To-Outlook Professional and you should get the menu

below:

Select the ACT-To-Outlook Professional options and the software will start.

To Download ACT-To-Outlook Professional
To download the latest version of ACT-To-Outlook Professional, click here.

Sub-topics

ACT-To-Outlook Professional Compatibility
Lists the system with which ACT-To-Outlook Professional is compatible with

License Registration
Instructions on the procedures on registering Email Address Validator

End-User License Agreement

Uninstall
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3.1 ACT-To-Outlook Professional Compatability

ACT-To-Outlook Professional is an Addon Product for ACT!. Hence, it requires the user to have
ACT! installed in the machine. ACT-To-Outlook Professional is compatible with ACT! 2000 or
above.

ACT! 2000/6.0 compatibility

ACT-To-Outlook Professional is compatible with the following versions of ACT!:
· ACT! 2000 with Service Pack 5.0.4.495 or 5.0.3
· ACT! 6.0 - All versions.

ACT-To-Outlook Professional may not work with ACT! 2000 without a service pack i.e. build
5.0.0. The programming interface in the original ACT! version has posed problems with ACT-
To-Outlook Professional and we suggest that if you are running an original version of ACT!, that
you upgrade.

What to do if you have the original ACT! 5.0.0 build?
You have to upgrade to ACT! to Version 5.0.4.495. The upgrade may be obtained for free from
act.com. Download the software (16mb) and execute it.

From our tests, V 5.0.4.495 has shown to be very reliable.

How to find out what version/build of ACT! you are running
To find out what version of ACT! you are running, do the following:

1. Click on Help->About ACT! on the ACT! Contact Screen
2. Check the Build Number on the right hand corner of the About Screen. The number of the

build has to be higher that 5.0.0.X which is the original release of ACT! 2000.

Outlook Compatibility
ACT-To-Outlook Professional is compatible with Outlook 2000 service pack 1 or higher, Outlook
2002, Outlook 2003 and Outlook 2007.

Operating System Compatibility
Email Address Validator for  ACT! is compatible with the following Windows operating systems:
· Windows 98
· Windows 98 - SE
· Windows Me
· Windows 2000
· Windows XP
· Windows XP Professional
· Windows Vista

3.2 Registration

Purchasing ACT-To-Outlook Professional
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To purchase ACT-To-Outlook Professional, click on the Buy/Purchase Button and it will take you
to the web site for purchase. When the product is purchased, you receive a license code (some of
our partners also call it a Serial Number), indicating that your product has been purchased and
paid for.

ACT-To-Outlook Professional Registration
When you purchase ACT-To-Outlook Professional, you are provided with a License Number (in
some cases it is called a purchase serial number). This number is your proof that you have
purchased the product.

To activate, enter the license in the Registration->License Activation screen. This will register your
software with ACT-To-Outlook.com's License Registration Server and enable your product.

The license provided to you will only work on 1 computer. If you attempt to activate the software
on another computer, the license server will not allow that.

ACT-To-Outlook Professional Registration Problems
To register, ACT-To-Outlook Professional sends a registration request to a license server. In
some cases, this registration request is blocked by a firewall. You'll get a message like
"Connection was forcibly interrupted" or "Failed to Connect". When such even happens, do the
following:

1. Clink on the Help->Manual License Registration
2. Enter the registration details and instructions to activate the product will be sent to you.
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3.3 End-User License Agreement

ACT-To-Outlook Professional

LICENSE AGREEMENT - ACT-To-Outlook.com Inc.

This is a user license agreement (the "AGREEMENT") between you (either individual or single
entity) and ACT-To-Outlook.com, Inc., for the version of the software (the "SOFTWARE")
accompanying this AGREEMENT.

The SOFTWARE is the property of PersonaCRM, Inc. and is protected by copyright laws and
international copyright treaties.  The SOFTWARE is not sold, it is licensed.

By availing of any of the rights licensed to you in this AGREEMENT, you agree to be bound by and
are becoming a party to this AGREEMENT.  If you do not agree to these terms and conditions, do
not avail of the rights licensed to you in this AGREEMENT.

If you accept the terms and conditions of this AGREEMENT, you have certain non-exclusive rights
and obligations as follow:

YOU MAY do any of the following:
· Use the Software for the Evaluation Period Provided;
· Use the Software for one SINGLE Computer only and for only 1 user;
· Use the Software on a network, PROVIDED that each person accessing the Software through

the network must have a copy licensed to that person or an authorized network multi-user
license.

· Copy the Software for archival purposes ONLY, provided any copy must contain all the original
Software's proprietary notices.

YOU MAY NOT:
· Permit other individuals to use the Software except under the terms listed above;
· Distribute, reveal, post, or disseminate the license key to any other users;
· Permit concurrent use of the Software except with a multi-user license;
· Modify, translate, reverse engineer, de-compile, disassemble (except to the extent applicable

laws specifically prohibit such restriction), or create derivative works based on  the Software;
· Copy the Software other than as specified above;
· Rent, lease, grant a security interest in or otherwise transfer rights to the Software
· Remove any proprietary notices or labels on the Software or its output;

All other rights with respect to the SOFTWARE are reserved. The SOFTWARE is Copyright (c)
2002 ACT-To-Outlook.com, Inc. All Rights Reserved

The Software is provided "AS IS", without a warranty of any kind.

ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES,
INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED.  ACT-To-
Outlook.com, INC. AND IT'S LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES
SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THE
SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL ACT-To-Outlook.com, INC. AND IT'S
LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT,
INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER
CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF
OR INABILITY TO USE SOFTWARE, EVEN IF ACT-To-Outlook.com, INC. HAS BEEN ADVISED
OF THE POSSIBILITY OF SUCH DAMAGES.



ACT-To-Outlook Professional15

© 2002 - 2007 ACT-To-Outlook.com Inc..

15 

ACT-To-Outlook.com, INC. DOES NOT INDEMNIFY ANY PARTY TO THIS LICENSE.

IN ANY EVENT, THE MAXIMUM LIMIT OF ACT-To-Outlook.com, INC.'S LIABILITY UNDER THIS
AGREEMENT IS $1.

ACT-To-Outlook.com, Inc. is not bound by any provision of any purchase order, receipt,
acceptance, confirmation, correspondence, or otherwise, unless  ACT-To-Outlook.com, Inc. is
specifically agrees to the provision in writing.  If any provisions, or portions thereof, of this
agreement are invalid under any applicable statute or rule of law, then that portion shall be deemed
omitted in the applicable jurisdiction and the remaining portions of the agreement remain in force.

3.4 Uninstall

To uninstall ACT-To-Outlook Professional, do the following:
· Click on Start->Settings->Control Panel
· Execute Add/Remove Programs from the Control Panel
· Select ACT-To-Outlook Professional from the listed programs
· Click Remove and ACT-To-Outlook Professional will be removed from your

system.

A Few Things
· Installing and Uninstalling will not reset the evaluation period for ACT-To-Outlook

Professional
· Uninstalling ACT-To-Outlook Professional will not reset the conversion counter



ACT-To-Outlook Professional

Accurately convert ACT! Databases into Outlook

Part

IV



ACT-To-Outlook Professional17

© 2002 - 2007 ACT-To-Outlook.com Inc..

17 

4 ACT-To-Outlook Pro Screens

ACT-To-Outlook Professional allows you to convert ACT! databases into corresponding Outlook
representations.
You can either convert the whole database using the Convert All button (available only when you
purchase the product) or selectively convert contacts using the Select option. For evaluation
purposes, you are allowed to convert a limited number of contacts.

ACT-To-Outlook Professional is run by selecting the Start->ACT-To-Outlook Professional icon
from the Start menu.
When you click on the program, the screen above will appear. If you want to run ACT-To-Outlook
Pro in the background, refer to
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4.1 The Main Screen

The Outlook Folders Tab
In the Outlook Folders Tab, the destination folders where ACT-To-Outlook Professional deposits the
data are defined.

With ACT-To-Outlook Professional you can select which
Outlook folder you want to deposit or update the data from
the ACT! 2000 database. By clicking on the Pick Folder
button, the form pops up which then allows you to enter the
destination folder(s) for your conversion.

Make sure that the folder selected matches the type that has
been requested i.e. Contact Folder should be of type Contact
Folder; Appointments folder should be the same as a
Calendar folder, etc..

These folders do not have to reside on your local machine. If your current version of Outlook can find
the folders, ACT-To-Outlook Pro can find them as well.

If a folder is left empty, ACT-To-Outlook will deposit the information in the default folder for that type
of information i.e. all Appointments will be created using the default Calendar folder.

ACT-To-Outlook Professional Toolbar
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There are seven icons in the toolbar that perform the following:

View. When pressed, the View button will display all the contacts in the database. From this viewer,
you can  consequently select which contacts you want to convert and then press the convert button.

When you receive the select contacts screen, you can
select single contacts or multiple contacts to convert.
Use the mouse with either the control key down (for
individual selections) or with the shift key (for a range
of  contacts) and select the contacts you want to
select.

The Select Contacts screen is displayed in using 3
filters selected from the View Drop-Down Menu:

· All. Open Filter, you get to see all the contacts.
· A2O Group. Here, the filter used is the group

selection active in the Group and Lookup tab.
· A2O Lookup. The filter applied here is the filter

setup in the Group and Lookup tab.

A2O Group. This button converts only the contacts selected in Group filter from the Group and
Lookup tab.
A2O Lookup. This button converts only the contacts selected in the Lookup Filter from the Group
and Lookup Tab.
Active Lookup. The contacts being viewed by the current ACT! lookup are converted into Outlook
Active Contact. The contact being viewed by the open ACT! is converted.
Calendar Only. This option will convert all the contacts that have a calendar items related to the
record that is logged in.
All. All the contacts in the database are converted.

The Active Lookup, Active Contact and All buttons are also available from the ACT! toolbar by
default. To add any of the other buttons to the ACT! toolbar, simply click on Tools->Add Icon to ACT!
Toolbar and the choices are then added to ACT!.

Enable Folder Size Limitation
Outlook folders has a size limitation of 16K Items for Outlook 2000 and 2002. Outlook 2003 does not
have such a limitation. Enabling size limitation, ACT-To-Outlook Professional allows only 12000
items to be created in a folder and no more. Once 12001 items are created, a new folder is created
and all subsequent items are created in the overflow folder. Overflow folders are the same name as
the initial folder but followed by a number; for example, Journal is the original folder, all overflow
folders are called Journal1, Journal2, etc..

If you disable folder limitation for Outlook 2000 and 2002 and the max number of items are stored in
the Outlook folder, Outlook will behave erratically and hang and possibly crash.
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4.1.1 Contact Options Tab

The Conversion Options screen provides you with Options to automate, filter and manage your
conversion process.

ACT-To-Outlook offers options for the conversion to make it easier to synchronize your Outlook data
with your ACT! data.

Duplicate Found Options
The Duplicate Found Options allow you specify what you want to do when a duplicate is found.

· Check for Duplicates – Indicates to the system to check for duplicates and perform smart
updates. Otherwise no duplicate search is enabled. If you are doing a conversion to an empty
outlook folder, uncheck this option since it speeds up processing.

· Clear Duplicate Before Update. When this flag is set, ACT-To-Outlook will clear the data in
the Outlook record before adding the information to the Outlook Duplicate Record.

· Ignore Update Dates. When set, ACT-To-Outlook Professional does not compare whether
an activity, contact, or meeting has changed in order to process the contact i.e. it simply goes
ahead and process the activated fields/activities independent of whether these fields have
been changed or not.

Enable Intelligent Updater
The Intelligent Updater, when enabled, does not process any items before the Update Cutoff Date.
This date is automatically set at the end of each successfull conversion i.e. the full conversion has to
go through and then the date is set. However, users can choose to change this date at their
choosing.

A few things about Intelligent Updater:
· The Intelligent Updater will only filter the items if the contact already exists in Outlook. If the

contact does not exist in Outlook, every item is then analyzed and processed for the contact.
· The Intelligent Updater takes the date entered in the Cutoff date and if an existent contact does

not have any changes made to it after the cutoff date, it will skip the item and go to the next one.
It applies this logic to the main contact data (the last time the contact was edited) and to the last
time the todo's, calls, meetings and history notes.

· The Cutoff date is always set after a full processing of a lookup, group or all conversion.
· If you conversion data shifts, for example, you convert a group, then a contact, then a lookup, it

is not advisable that you use the Intelligent Updater since the base data changes so many items
may not be converted when they should.

When Intelligent Updater is used with a fixed conversion base, you will dramatically improve
conversion speeds.
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Options
The options check boxes represent the following:

· Add Date to Subject Line. When items are converted into Outlook, the date in ACT! is
inserted in the subject line. This simplifies visual searches by date.

· Convert ACT! Groups into Outlook Categories. All the groups to which the contact belongs to
in ACT! and convert them into Categories in Outlook.

· Include Private Contacts. When checked, all private contacts are converted as well. When
unchecked, private contacts are not included

· File Contact As:. This enables the user to specify how to create the keywords for the record in
Outlook. These keywords determine how the contact is identified in the Outlook Contact
Book.

In the File Contact As, you can set the filing as Custom. When custom is chosen, another set
of options make themselves available:

You must then build the FileAs string. All the ACT! fields MUST be enclosed in right
parenthesis [ACT! Field] for the parsing mechanism to do it properly.

Building a FileAs String.
Click on the Build button and the
build screen is displayed. Select
which fields you want to appear
in your fileas screen and
separate them using whatever
strings you wish.

Do not use square parenthesis
of your own on the build string.
The parenthesis are reserved
for parsing the string. However,
you can use any other string.

Whatever you insert in the
string, that is the way the
contact will be entered into
Outlook.

·  Form To Use. If you defined your own custom contact form in Outlook, enter the name here.
The name of the form must match the name in Outlook. If there are any discrepancies, the
conversion of the contact will not succeed. Outlook form names are generally named
"IPM.Contact.FormName", where "IPM.Contact" indicates to Outlook that this is a contact
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form. ACT-To-Outlook Professional attaches the prefix "IPM.Contact." to the name of the
form in this field. Hence, you only need to enter the name of the form, in our case FormName.

Addressing Options
· Merge Address 1, 2, and 3 into one string. When enabled (default), this option takes the

standard address fields in ACT and merges them into one single string with the fields
separated by returns. This makes the addresses "Outlook friendly". The address fields
converted are Address 1,2, and 3 and Home address 1 and 2. Note: you must not map
Address 2 and Address 3 in order for this option to work. Make sure that you have Address 1
enabled. If Address 2 and 3 are mapped, the address field will be overwritten

· Add phone number extension to Phone number. When set, this option adds the phone
number extension to the end of the phone number. For example, Outlook only provides 1 field
to add a phone number to. Hence, this feature will take the standard phone fields with
extensions and put merge them to make one field in Outlook.

· Remove Phone # Country Code. When this option is set, ACT-To-Outlook Convert
professional will remove the country code specified in CC form the phone number. The
reason this option is available is because ACT! provides the phone number in the format of
+1 (408) 555-1212 where +1 is the country code, (408) is the area code, and 555-1212 is the
phone number. Some installations of Outlook will accept this phone number. However, others
will not. Hence, you can specify ACT-To-Outlook Professional to remove a specified country
code.

· Add Hyphen to Phone Number. Some ACT! configurations provide the phone number as a
string of 7 digits i.e. 1234567 and Outlook will import those phone numbers and not add the
customary hyphen to the phone number. By setting this option, you can force the phone
number to have a separating hyphen on the last 4 digits before they are imported i.e. The
number would look like 123-4567 therefore making it more legible.

· Use Company Name when Name does not exist. Outlook requires a contact name in order for
the links to function properly. This option instructs ACT-To-Outlook Professional to replace
the company name in the name field of FileAs so that the contact get's saved properly and
links to the contact work well. If this option is not set, the user will be queried for every
instance of this problem.

4.1.2 Contact Fileds Tab

Click on the fields on the picture to find out what it does.

ACT-To-Outlook Pro provides users with a standardized set of fields. However, for users that have
customized fields defined, the fields remapping feature provides the avenue for users to successfully
move over data from custom fields. There are 3 types of fields, namely: s for String, d for Date, and n
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for numbers.

4.1.2.1 Mapping ACT! Fields To Outlook

There are various ways to map Outlook fields to ACT! fields. ACT-To-Outlook Professional provides a
set of default field mappings but you can map any field in ACT! to an existent or to a new field in
Outlook.

Mapping To Outlook Fields

The process of mapping Standard Outlook fields to ACT! fields is done as follows:
1. Select which ACT! field you want to map. Enable the mapping by clicking on the check box.
2. Click on the Standard field in the Outlook Field List.
3. Click on the arrow button to bring over the field map.

The field mapping is automatically saved. If you'd like to remove the field mapping, simply click on the
reverse arrow and the map will be removed. Pressing the Del key will also remove the mapping.

4.1.2.2 Adding Outlook User Defined Fields

Setting up the Outlook User Defined Fields
All Outlook User Defined Fields are displayed in Bold in the User defined field list. ACT-To-
Outlook Professional allows the user to create corresponding Outlook User defined fields for ACT!
records.

· Add Outlook User Defined Field: add a user defined field to Outlook by simply typing in the
input box. Duplicate fields will be ignored. Also, all fields are considered to be of type string.
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· Remove Outlook User Defined Field: remove the selected Outlook user defined property
from the list of defined fields. You can only remove user defined fields.

· Retrieve User Properties from Existing Contacts. If you already have outlook contacts that
have the user defined fields that you want, you can search outlook for these fields using this
option. This option creates a screen that displays all the contacts in the Outlook Contact
Database and when you click on the contact, it will display the user fields defined for that
contact.

By clicking on the contact, this screen displays the user defined fields found for the contact.
Note: if the user defined field has an empty value, Outlook does not see it as a user
defined field and it will not appear in the list!
To add these user fields to the list of user fields that you want to create, select the Add
Outlook User Fields button.

4.1.2.3 Outlook and ACT! Fields

All Outlook Fields that are write/read are available to be overwritten. Fields that are Read-Only in
Outlook cannot be overwritten by ACT-To-Outlook Professional. The fields below cannot be overwritten
by the conversion.

Fields that cannot be overwritten in Outlook
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Actions
Application
Class
CompanyLastFirstNoSpace
CompanyLastFirstSpaceOnly
ConversationIndex
ConversationTopic
CreationTime
EmailDisplayName
EmailEntryID
Email2DisplayName

Email2EntryID
Email3DisplayName
Email3EntryID
EntryID
FormDescription
FullNameAndCompany
GetInspector
LastFirstAndSuffix
LastFirstNoSpace
LastFirstNoSpaceCompany
LastFirstSpaceOnly

LastFirstSpaceOnlyCompany
LastModificationTime
LastNameAndFirstName
Links
OutlookInternalVersion
OutlookVersion
Parent
Saved
Session
Size

Street Address Fields and Phone Numbers
Street Address fields are handled differently between ACT and Outlook. In ACT, the street address
fields are defined as Address1, Adress2 and so on. In Outlook, the street address fields are one field
separated by returns (carriage-return-line-feed).
Hence, ACT-To-Outlook Professional provides users with the option to merge address and phone
number fields to be Outlook Friendly.

ACT! Representation Outlook Representation

Field Example Field Example

Contact's Street Address Outlook Street Address

Address 1 1892 Washington BusinessAddressStreet 1892 Washington
Apartment A
Suite 202

Address 2 Apartment A

Address 3 Suite 202

Contact's Home Address Outlook Street Address

Alt Address 1 1892 Washington HomeAddressStreet 1892 Washington
Apartment A
Suite 202

Alt Address 2 Apartment A, Suite 202

Contact's Phone Number Outlook Phone Number

Phone 408-773-9380 BusinessTelephone
Number

408-773-9380 Ext. 2343

Ext 2343

All other phone numbers in ACT! are dealt with in the same way i.e. the extension is applied directly
to the phone number, unless the merge fields feature is not set.

4.1.2.4 Email Addresses

An ACT! contact can have an unlimited number of Email Addresses while Outlook only allows 3
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"standard" email addresses, namely Email1Address, Email2Address, Email3Address. ACT-To-Outlook
converts email addresses using the following logic:

· The ACT! default (or Primary) email address gets converted to Email1Address

· Any other email addresses found in the database get converted into Email2Address and
Email3Address. If there are more than 3 Email addresses for the contact, the remaining email
addresses get converted to User Properties named Email#Address where # is a number
starting at 4 and increasing for every additional Email Address found for the ACT! Contact
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4.1.2.5 ACT! Standard Fields

Database

schema name Field name Description

ADDR1 Address 1

("Address"
displays)

First line of the contact's primary
address.

ADDR2 Address 2

Second line of the contact's
primary address. This field is
spliced with ADDR1

ADDR3 Address 3 Third line of the contact's primary
address. This field is spliced with
ADDR1

ALT1REACH 2nd Last Reach

(not displayed
unless added in
the Layout
Designer)

Date of the last completed call
to the second contact. The
format is YYYYMMDD. This
field is supplied by the system.

ALT2REACH 3rd Last Reach

(not displayed
unless added in
the Layout
Designer)

Date of the last completed call
to the third contact. The format
is YYYYMMDD. This field is
supplied by the system.

ALTADDR1 Home Address 1 First line of the contact's home
address.

ALTADDR2 Home Address 2 Second line of the contact's
home address.

ALTCITY Home City City in the contact's home
address.

ALTCOUNTRY Home Country Country in the contact's home
address.

ALTEXT Alt Phone Ext.

("Ext." displays) Extension for the contact's
alternate phone number.

ALTPHONE Alt Phone Contact's alternate phone
number.

ALTSTATE Home State State in the contact's home
address.

ALTZIP Home Zip Zip code in the contact's home
address.

ASSISTANT Assistant Name of the contact's assistant.

ASST_EXT Asst. Phone Ext.

("Ext." displays) Extension for the phone number
of the contact's assistant.

ASST_PHONE Asst. Phone Phone number of the contact's
assistant.

ASST_TITLE Asst. Title Title of the contact's assistant.

CITY City City in the contact's address.

COMPANY Company Contact's company name.

CONT_TYPE Contact Type Contact record type.

Values are:
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CREATOR Record Creator The database user who created
the contact record. This field is
supplied by the system.

CTIME Create Timestamp

("Create Date"
displays)

Date and time the contact
record was created. This field is
supplied by the system and
stored in a compressed format.

DEPARTMENT Department Contact's department.

ETIME Edit Timestamp

("Edit Date"
displays)

Date and time the contact
record was last modified. This
field is supplied by the system
and stored in a compressed
format.

EXT Phone Ext.

("Ext." displays) Extension for the contact's
primary phone number.

FAX Fax Contact's fax number.

FAX_EXT Fax Ext.

(not displayed
unless added in
the Layout
Designer)

Extension for the contact's fax
number.

FNAME First Name

(not displayed
unless added in
the Layout
Designer)

Contact's first name. This field
is parsed by the system from
the contact.

HOME_PHONE Home Phone Contact's home phone number.

IDSTATUS ID/Status Category assigned to the
contact.

LAST_ATMPT Last Attempt Date of the last attempt to call
the contact. The format is
YYYYMMDD. This field is
supplied by the system.

LAST_MEET Last Meeting Date of the last meeting with the
contact. The format is
YYYYMMDD. This field is
supplied by the system.

LAST_REACH Last Reach Date of the last completed call to
the contact. The format is
YYYYMMDD. This field is
supplied by the system.

LAST_RSLTS Last Results Comments on the last results
with the contact.

LNAME Last Name

(not displayed
unless added in
the Layout
Designer)

Contact's last name. This field is
parsed by the system from the
contact name.

LTTR_DATE Letter Date Date of the last letter sent to the
contact. The format is
YYYYMMDD. This field is
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PAGER Pager Contact's pager number.

PHONE Phone Contact's primary phone number.

PHONE2 2nd Phone Second contact's phone number.

PHONE2_EXT 2nd Phone Ext.

("Ext." displays) Extension for the second
contact's phone number.

PHONE3 3rd Phone Third contact's phone number.

PHONE3_EXT 3rd Phone Ext.

("Ext." displays) Extension for the third contact's
phone number.

PUB_STATUS Public/Private Access level for the contact.

Values are:

1  Public
(default)
2  Private

REFER_BY Referred By Description of the contact's
referral source.

SALUTATION Salutation Contact's letter salutation or
greeting name.

SPOUSE Spouse Name of the contact's spouse.

STATE State State in the contact's address.

TICKERSYM Ticker Symbol Company's stock ticker symbol
for ACT! 4.0 or later databases
only.

TITLE Title Contact's title.

TITLE2 2nd Title Second contact's title.

TITLE3 3rd Title Third contact's title.

UNIQUE_ID Unique Id Unique contact record
identification number. This field is
supplied by the system.

URL Web Site Contact's web site URL address.

USER Record Manager The Unique ID of the database
user permitted to access and
change the status of private
contacts. This field is supplied by
the system.

USER1 User 1 User-definable field 1.

USER2 User 2 User-definable field 2.

USER3 User 3 User-definable field 3.

USER4 User 4 User-definable field 4.

USER5 User 5 User-definable field 5.

USER6 User 6 User-definable field 6.

USER7 User 7 User-definable field 7.
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USER8 User 8 User-definable field 8.

USER9 User 9 User-definable field 9.

USER10 User 10 User-definable field 10.

USER11 User 11 User-definable field 11.

USER12 User 12 User-definable field 12.

USER13 User 13 User-definable field 13.

USER14 User 14 User-definable field 14.

USER15 User 15 User-definable field 15.

ZIP Zip Zip code in the contact's
address.
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4.1.2.6 Outlook Standard Fields

Name Description

Account Specifies the account information

Anniversary Specifies the date of the contact's anniversary

AssistantName The name of the contact's assistant

AssistantTelephoneNumber The telephone number for the contact's assistant

BillingInformation Contains a free-form string that can be used to
hold the billing information associated with the
item.

Birthday The date of the contact's birthday

Body A free-form string containing the body of the
item.

Business2TelephoneNumber The second business telephone number for the
contact

BusinessAddress The entire unparsed business address for the
contact

BusinessAddressCity The city part of the contact's business address

BusinessAddressCountry The country part of the contact's business address

BusinessAddressPostalCode The postal code part of the contact's business
address

BusinessAddressPostOfficeBox The Post Office Box of the contact's business
address

BusinessAddressState The state code for the contact's business address

BusinessAddressStreet The street information for the contact's business
address

BusinessFaxNumber The contact's business fax number

BusinessHomePage The URL of the home web page of the business

BusinessTelephoneNumber The contact's business telephone number

CallbackTelephoneNumber The telephone number at which the contact may
be called back

CarTelephoneNumber The contact's car telephone number

Categories Specifies the categories that are assigned to the
item.

Children The names of the contact's children

Companies A free form string containing the company names
associated with the item

CompanyMainTelephoneNumber The main telephone number for the contact's
company

CompanyName The name of the company that the contact works
for



ACT-To-Outlook Pro Screens 32

© 2002 - 2007 ACT-To-Outlook.com Inc..

32 

Email1AddressType The address type ("SMTP") of the contact's first
email address

Email2Address The contact's second email address

Email2AddressType The address type ("SMTP") of the contact's
second email address

Email3Address The contact's third email address

Email3AddressType The address type ("SMTP") of the contact's third
email address

FileAs The keyword for the contact

FirstName The contact's first name

FTPSite The contact's FTP site entry

FullName The contact's whole name

Gender The gender of the contact

GovernmentIDNumber The government ID number for the contact

Hobby The contact's hobby

Home2TelephoneNumber The second home telephone number for the
contact

HomeAddress The entire unparsed home address of the contact

HomeAddressCity The city part of the home address

HomeAddressCountry The country part of the home address

HomeAddressPostalCode The postal code part of the home address

HomeAddressPostOfficeBox The Post Office Box of the home address

HomeAddressState The state code for the home address

HomeAddressStreet The street information for the home address

HomeFaxNumber The contact's home fax number

HomeTelephoneNumber The home telephone number of the contact

Importance Specifies the importance of the contact (0=low,
1=medium, 2=high)

Initials The initials of the contact

InternetFreeBusyAddress The URL for the contact's free/busy information

ISDNNumber The contact's ISDN number

JobTitle The contact's job title

Journal Specifies whether all the transactions are to be
entered into the journal

Language The language for the contact

LastName Specifies the contact's last name
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MailingAddress The entire unparsed mailing address of the
contact

MailingAddressCity The city part of the mailing address

MailingAddressCountry The country part of the mailing address

MailingAddressPostalCode The postal code part of the mailing address

MailingAddressPostOfficeBox The Post Office Box of the mailing address

MailingAddressState The state code for the mailing address

MailingAddressStreet The street information for the mailing address

ManagerName The name of the manager of the contact

MiddleName The middle name of the contact

Mileage Mileage record for the contact

MobileTelephoneNumber The contact mobile phone number

NetMeetingAlias The contact's ID or alias for Net Meetings

NetMeetingServer The name of the server to host the Net Meeting

NickName The contact's nickname

OfficeLocation The office location information for the contact

OrganizationalIDNumber The organizational ID number for the contact

OtherAddress The entire, unparsed for of another address for
the contact

OtherAddressCity The city part of the other address

OtherAddressCountry The country part of the other address

OtherAddressPostalCode The postal code part of the other address

OtherAddressPostOfficeBox The Post Office Box part of the other address

OtherAddressState The state code for the other address

OtherAddressStreet The street information for the other address

OtherFaxNumber Another Fax Number for the contact

OtherTelephoneNumber Another Telephone Number for the contact.

PagerNumber The contact's pager number

PersonalHomePage The URL for the contact's personal home page

PrimaryTelephoneNumber The primary phone number for the contact

Profession The profession for the contact

RadioTelephoneNumber The radio telephone number of the contact
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ReferredBy The name of the person that referred this contact
to you.

Sensitivity Specifies the level of sensitivity for the contact
(0=normal, 1=personal, 2=private,
3=confidential)

Spouse The name of the contact's spouse

Subject Contains the subject of the item

Suffix The contact's suffix

TelexNumber The contact's telex number

Title The contact's Title

TTYTDDTelephoneNumber The TTY/TDD telephone number for the contact

User1 The first MS Schedule+ user for the contact

User2 The second MS Schedule+ user for the contact

User3 The third MS Schedule+ user for the contact

User4 The fourth MS Schedule+ user for the contact

UserCertificate The authentication certificate for the contact

WebPage The URL for the contact's web page

YomiCompanyName The Japanese phonetic rendering of the company
name

YomiFirstName The Japanese phonetic rendering of the contact's
first name

YomiLastName The Japanese phonetic rendering of the contact's
last name

4.1.3 Activities Tab

Activities Conversion Options

The Activities Conversion options allows you to convert/update activities that exist in the Notes/History
of ACT!.
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Activities to Convert
· To Do's. You can enable or disable conversion of Todo's.
· Calls. You can enable or disable conversion of calls.
· Meetings/Appointments. You can enable or disable conversion of meetings.
· Convert Alarms. This option enables the creation of Outlook alarms for ACT! alarms for todo's,

calls, and meetings/appointments. Most ACT! activities tend to have the alarm set but the user
has disabled it via either the snooze button or by some other means. The alarm, however, still
lingers and will pop-up in Outlook as an item to be be dealt with. Disabling the conversion of the
alarm flag, you basically do not activate Outlook alarms. If the database is clean and the
activities well maintained, converting alarms should not be a problem. However, if you have lots
of old alarms that have not been dealt with, these alarms will popup in Outlook with an annoying
speed. Hence, we provide you with the option of converting/not converting the alarms. By
default, we do not convert the alarm.

· History/Notes. Convert all the history and notes for all the contacts into outlook Journal Entries
and Notes when applicable.
o Convert Notes into Journal. This is the recommended option to convert Notes from ACT!

to Outlook. ACT-To-Outlook can convert ACT! Notes into Outlook Notes. However, If you
prefer to convert the ACT! Notes into Outlook Quick Notes, you may do so.

o Convert Notes into Body Text.  All the selected activities for the contact are converted
into the Outlook Body text for the contact form

· Date Filter. This allows you to filter out activities before a specific date i.e. if you only want ACT-
To-Outlook Professional to convert activities that happened after Jan 1, 2002, you set the date
here to be Jan 1, 2002 using the provided date picker and consequently no Activity before Jan 1,
2002 will be converted. It allows you to select/deselect what type of history items you want
transferred to Outlook. This prevents over populating the Outlook journal with information that
may not be necessary (such as field changed history record).

· Add Name to Activity Subject Line. This option will add the contact's name to the begining of
the activity subject line in Outlook. This makes it easier to see with whom an activity is scheduled
with.

· Include Private Activities. This option enable/disables the inclusion of private activities (with the
private flag set) to be transferred to Outlook.

Outlook Forms
If you use customized outlook forms for Tasks, Activities, and Appointments, enter the form names
here.

History/Notes Dates
Due to restrictions in Outlook, when a Journal item is created, the date of creation of that item is the
day of the execution of ACT-To-Outlook Professional. However, this does not match the ACT!
recording date. Hence, when ACT-To-Outlook Professional creates Journal entries, each entry is
provided with a custom variable called ACTRecordedDate which can then be used as the date is
the design of custom forms.



ACT-To-Outlook Pro Screens 36

© 2002 - 2007 ACT-To-Outlook.com Inc..

36 

4.1.4 Group and Lookup Tab

The group and lookup Tab allows you to pre-define selected groups to convert (which are named A2O
Groups) or Lookup fields to use when selecting contacts to convert. You can view the contacts that are
defined by these fields by clicking on the View->A2O Groups or View->A2O Lookup option.
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5 Using ACT-To-Outlook Professional

You can run ACT-To-Outlook Professional from 2 places:
1. The Start menu in the windows toolbar
2. The icon in the ACT! toolbar.

Converting Contacts
ACT-To-Outlook Professional allows you to convert contacts in two modes:

· Selective Conversion. This is where you select contacts or groups to convert .
· Convert All. Click on a button and all contacts are converted.

When a duplicate contact is found, only contacts that have been updated are transferred.

Selective Conversion
When you first open selective conversion, all the contacts in the database are listed. You can select
one or a range of contacts using the mouse and the Ctrl or Shift button. Pressing Convert will convert
the selected contacts. Selective conversion operates in two modes:
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All the options set on the main screen are inherited into this screen. By clicking on the header, the
names will sort themselves ascending or descending order.

In this mode, all the contacts that exist in the database are displayed. By clicking on the column
headers, you are able to sort the records alphabetically in descending and ascending order.
All the options set on the main screen are inherited into this screen. By clicking on the header, the
names will sort themselves ascending or descending order.

A2O Group Mode Selective Conversion

In Group mode selective conversion, you can select groups
that exist in ACT! and display these groups for conversion. By
clicking on the Select Group button, the Existent ACT groups
that exist in the database are displayed as shown below. The
numbers in parenthesis are the number of members in each
group.

  
When a group is selected only the first and last name of the contact is displayed. To return to normal
display, exit the selective contacts conversion and restart it again.

A2O Lookup Mode Selective Conversion
In this mode, all the records are selected according to the lookup criteria in ACT-To-Outlook

Professional.

Active Lookup Conversion
In the Active Lookup Conversion, the contacts that are displayed in the current lookup in ACT! are
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converted. ACT-To-Outlook Professional will first go through the lookup and then it starts to
convert the data.

Active Contact Conversion
In the Active Contact Conversion, the contact that is currently being displayed in ACT! is converted
into Outlook.

Convert All
Clicking this options allows you to convert all the contacts in the database.

Interrupting a conversion
To interrupt a conversion, click on the stop button on the front form of ACT-To-Outlook
Professional and the conversion will stop. Remember, the stop button only comes visible when a
conversion is in progress.

5.1 Empty Contact Names

You will receive the screen below if ACT-To-Outlook Professional encounters a contact that has no
name. Outlook establishes the basis for all task, calendar, and journal entries via a linking system on
the existence of a valid name i.e. a name other than empty. Hence, ACT-To-Outlook Professional
checks whether first and last name are set for the contact. When these fields result in empty, the "No
name for this contact" dialog appears.

When this dialog appears, you are provided with the contact
details via the roll down list and you can take the following
actions:

1. You can ignore this contact. ACT-To-Outlook
Professional then continues to process the next
contact

2. You can set the name for the contact to be set in
Outlook. Enter the name in the name box to enter the
new name. You can look through the list and
determine what the name of the contact is.

3. Apply Button. This instructs ACT-To-Outlook
Professional to continue processing. Remember, if the
blank name contact has any activities, todo's,
calendar, or journal entries, they will not be linked to
the contact

4. Cancel Conversion Button. This instructs ACT-To-
Outlook Professional to cancel the conversion of the
ACT! Database into Outlook.

5. Do not ask again. Instructs ACT-To-Outlook
Professional to continue processing this contact and in
the event of another contact being blank named,
continue processing.

5.2 Background Processing

ACT-To-Outlook Professional can be run in the background if the command -Background is passed to
it.
The best way to do this is to add this command to the Windows Scheduler and run the software
periodically.
Here's an example of a command line that would start ACT-To-Outlook Professional in the
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background:

To Convert All the Contacts:
       C:\Program Files\ACT-To-Outlook Pro\act2opro50.exe –B -A -V -M

To Convert a Stored Group
       C:\Program Files\ACT-To-Outlook Pro\act2opro50.exe –B -G -V -M

To Convert a Stored Lookup:
       C:\Program Files\ACT-To-Outlook Pro\act2opro50.exe –B -L -V -M

To Convert the calendar:
       C:\Program Files\ACT-To-Outlook Pro\act2opro50.exe –B -N -V -M

This instructs ACT-To-Outlook Professional to process all contacts in background mode. The following
options are available to ACT-To-Outlook Professional

-B - Process the contacts in the background
-V - Enable verbose processing
-G - Convert using the A2O Group settings
-L - Convert using the A2O Lookup settings
-A - Convert All (no filtering)
-C - Convert the current contact
-K - Convert the current ACT! lookup.
-N - Convert calendar items only

Note: Make sure that ACT-To-Outlook Professional is working properly before scheduling for
background processing.

5.3 File Options

In the File Options, you are provided with 4 options:
· Re-Open the Database. This will reset the current username/passwords and re-open the

database.
· Retrieve Default Outlook Folders. This option will open Outlook and retrieve all the default folders
· Retrieve CurrentACT! Database. This option will retrieve the current ACT! Database that is being

accessed via the ACT! interface. You must have ACT! open for this feature to work.
· Exit. As said, it will exit.
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5.4 Adding Icons to ACT!

This option is accessed through the Tools Menu. By enabling/disabling each icon, you can add or
remove the icons from the ACT! toolbar for fast access to ACT-To-Outlook Professional features.

Icons and what they represent:
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ACT-To-Outlook Professional Icon
This is ACT-To-Outlook Professional's icon. Installing this icon on ACT!'s
toolbar allows you to have direct access to the software by simply clicking on
the icon.

Convert A2O Stored Group
This icon converts the stored group that is selected using the groups and
lookup tab. It will either show the whole main screen of A2O Pro if "Show
Main A2O Pro Screen When Converting" is set or it will only indicate to the
user when it starts and when it finishes converting when "Show Main.." is
unset.

Convert A2O Stored Lookup
This will convert the stored lookup that exists in the Groups and Lookup
Tab. It will either show the Main A2O Screen when "Show Main A2O Pro
Screen" is set or it will only provide start and finish prompts.

Convert Active Lookup
This icon, when pressed, will start the conversion of the Active Lookup in
ACT! i.e. the lookup that the user is currently looking at in ACT!. So you can
establish a lookup in ACT!, filter out contacts from the lookup and then
convert the lookup. A2O Pro will go through the lookup and establish a
selection of the contacts. Consequently, it will convert the contacts. Also, the
"The Show Main A2O Pro Screen" will show the main screen while
converting (when set) or will only show the start and end of the conversion.

Select and/or Convert Group
This icon will display a tree structure of the groups available in the database.
You then select which group you want to convert and then press the convert
button. This feature will display the main screen while converting and it
unnaffected by the "Show Main Screen" option.

Convert Active Contact
The contact being displayed by ACT! is converted.

Convert Calendar
Only the contacts with which the Current User has calendar items
associated with are converted.

Convert All
All the contacts are converted in the database. This option will show the
main screen when "Show Main Screen" is set or it will only prompt for the
begining and end of the conversion.

In essence, when the "Show Main A2O Pro Screen When Converting" is set, the user gets informed
when the conversion begins and end.

5.5 Group Conversion

ACT! provides users with 2-level groups while Outlook only provides users with single level Categories.
Hence, when groups are converted into Categories, the groups are defined in the following manner:

Master_Group is converted into Master_Group
Master_Group with Subgroups is converted in Master_Group.Subgroups where the . defines the
sub groups.
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6 Tips and Tricks

The following Topics are available:
· Increasing Speed
· Converting Addresses
· Errors

6.1 Increasing Speed

One of the major issues with ACT-To-Outlook Professional is speed. Unfortunately, the processing is
slow due to 2 major factors:

1. The slow speed of ACT!
2. The slow speed of Outlook

In addition, if you are doing processing across a network, the performance will also decrease. Hence, a
few things that may make life easier:

· Try to do processing on the local drive as much as possible. Retrieving data across a network is
cumbersome and slow.

· Have Outlook fetch all the email before the processing begins. When Outlook is downloading
email, our software cannot access the data structures.

· Use History Filtering. Convert only the items in History that you want in addition to the using Date
Filtering to reduce the amounts of history items being converted/analyzed.

· Disable Email Retrieval on the Outlook Account.
· Run the process in the background so that you don't have to be there when converting.
· When converting to an empty contact folder, disable duplicate checking. That will increase speed

by 40%
· If you have a fixed conversion base, enable the Intelligent Updater and that may increase full

conversion speeds by up to 1000%

Stepwise Conversion Options
From experience and from the latest versions of ACT! and Outlook, we've found that the best way to
convert the data is to do it in different steps:

1. Convert the contact data first. Disable all the conversion of todo's, call's, meetings and specially
history. Also, disable duplicate checking.

2. Make sure that the quantity of history records is less than 16,000. Limit their conversion by
setting the date filter so that unneccessary history records are not converted. Enable duplicate
checking here to convert the records.

6.2 Converting History

In order to speed up conversion, it is recommended that you restrict the conversion of history items.
This can be done in several ways:

1. Set a date in the date filter as the earliest date to convert
2. Remove (clean) your ACT! database of any old history records
3. Only transfer usefull history records i.e. notes and so on. Do not transfer field changes and other

historical data that does not really have any effect on the contacts data.

6.3 Converting Addresses

In Outlook, street addresses are represented differently than in ACT! In ACT!, street addresses are 3
fields while in Outlook it is only 1 field. ACT-To-Outlook Professional provides users with the capability
to Merge all three addresses into 1 Outlook Field. In addition, it will also convert the 2 fields that ACT!
has for representation of Home Address into 1 Outlook Field.
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To enable this feature, click on the "Merge Address 1, 2 and 3 into one string" option in the conversion
options.

Note: You must enable Address 1 and Home Address 1 to be converted in the Contact Field Mappings.
Otherwise, ACT-To-Outlook Professional will ignore the Address conversions.

6.4 Limitations

Outlook Folder Limitation
ACT-To-Outlook Professional limits the number of entries on an Outlook Folder to 12,000. Any entries
beyond 12000 items, a new folder is created of the same type and the additional entries are posted to
this "overflow" folder. In most cases, this applies primarily to the Journal folder where thousands of
ACT! history items are stored. When the Journal folders exceeds 12,000 items, additional folders are
created namely Journal1, Journal2 and so on...

Outlook 2000 and 2002 limits the number of entries for folders to 16K. From our experience, if you put
more than 12,000 items in a folder, Outlook's performance degrades tremendously and in some cases
it even locks up. Hence, we've put a limit of 12,000 items for the folder.

If you happen to have multiple folders that were created during the conversion, you must expand the
search path of the Contacts folder to include the additional folders from the conversion. This is done by
right clicking over the contact folder and selecting Properties. Then modify the Activities Tab to include
the additional folders in the search path. The reason for doing this is to make sure that when you press
the Activities Tab that Outlook will search all the proper folders for related activities to the contact.

Duplicates
Duplicates are only checked on the folders that are set. Duplicates are not checked on overflow
folders. If you happen to have overflow folders, clean up your database or use a date filter to reduce
the size of the folder.

Memory Limitations
ACT-To-Outlook Professional may run out of memory under the following circumstances:

· If you enable History Recording to the Contact Body Text and you have a large number of history
records for that contact. This occurs primarily when you are converting My Records or a record
that has thousands of history entries. ACT-To-Outlook Professional will save the history into a
local temporary file and then read that file to the Outlook contact record. However, if the file is too
large, Outlook will run out of memory and the history can't be converted.

Solution: Either clean up the history in ACT! and erase all old records or set the date filter in ACT-
To-Outlook Professional to only pick Activity items after a certain date.

6.5 Errors

ACT-To-Outlook Professional errors are generally followed by a code and a string that explains the
error. From past experience, ACT-To-Outlook Professional generates very few errors once it is setup.
The product has been out for over 2 years and we believe that most bugs have either been found or
exterminated (literally). Ever so often we get calls re. errors and here is a list of actions you can take to
resolve the error:

Errors with retrieving Outlook Folders
This error occurs when you've changed folders in Outlook and ACT-To-Outlook Pro cannot find the
default folder. The message is in general:

"ACT-To-Outlook Professional: Error on retrieving Tasks Folder"
"ACT-To-Outlook Professional: Error on retrieving Contacts Folder"
"ACT-To-Outlook Professional: Error on retrieving Appointments/Calendar Folder"
"ACT-To-Outlook Professional: Error on retrieving Journal/Activities Folder"
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"ACT-To-Outlook Professional: Error on retrieving Notes Folder"

Solution 1
1. Click on the Outlook Folders Tab
2. Click on the Pick Folder button for each Outlook Folder and select the corresponding Outlook

folder.

3. Do this for each folder.

Solution 2
1. Click on File->Retrieve Default Outlook Folders. This will retrieve the Outlook Default Folders

into the folders in question and reset them to the default.

Note: This section is new and we will be expanding it re. any issues with errors with ACT-To-Outlook
Professional. Check our online help for any additions and solutions before you contact ACT-To-
Outlook.com.
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